**Contents**

Welcome to LogTen Pro for Mac 3  
Features at a glance 4  
What’s New 9  
Configuring LogTen Pro 11  
Setting Preferences 13  
Entering Flights 18  
Trips 24  
Reports 27  
Types 34  
Aircraft 35  
Places 36  
People 40  
Certificates 41  
Smart Groups 42  
Syncing 49  
Frequently Asked Questions 52  
Troubleshooting 57
It’s my Logbook.

Coradine’s LogTen Pro is the most flexible, powerful and easy to use logbook solution on the market.

- Easily import existing data and customize to your needs
- Automatically tracks currency and duty limits, and enables you to filter your time based on virtually any aspect of your flights using powerful Smart Groups
- Prints stunning reports and logbooks for most official formats
- Works seamlessly with our applications for the iPhone and iPad
- Free for student pilots*
- and a lot more …

This guide describes the features of LogTen Pro and shows you how to use it. If you can’t find what you’re looking for then by all means don’t hesitate to send us an email and we’d be happy to help.

At Coradine we prize excellent service. Our goal is to deliver service “above and beyond”, a level of quality surpassed only by our desire to bring you the best aviation software tools in the industry.
Out of the box: One step configuration

When you open LogTen Pro Mac for the first time, we make getting started simple by setting your configurations based on the type of flying you do. This configuration is then easily customized later should you wish to change your settings.
Everything you need, intuitively laid-out

At Coradine, we’ve worked hard to create a dashboard that is simple, elegant and clear. LogTen Pro opens in the “Flights” view and provides pilots with all the information they need to manage their flight time.

The groups area (left) enables you to track limits, currencies and see total flight time. Pilots can set up Smart Groups to track total time based on virtually any attribute of their flights.

The table view (top center) gives you all the information regarding your flight time and is totally customizable. Change column names then drag and drop columns into your desired configuration.

The Flight Detail View (bottom center) enables you to input all pertinent data without leaving the flight view screen, AND gives you the ability to edit multiple flights at once!
The LogTen Pro Toolbar

The toolbar gives you one touch access to your Flights, Trips, Types, Aircraft, Reports, Places, People and Certificates. You can add, remove and rearrange buttons to suit your working style.

The default set of toolbar buttons is shown below:

FLIGHTS
Shows flights, currencies, limits, totals and details for all flights.

TRIPS
Enables pilots to track multiple legs together and track time whether in the air or on the ground, including per diems, expenses, etc.

REPORTS
Prints stunning reports and logbooks for most official formats.

TYPES
Track all your aircraft types, from Cessna 172's to Boeing 777-300's.

AIRCRAFT
Track each individual aircraft you fly.

PLACES
Enter an ICAO or IATA ID and we can automatically fill in the details from our comprehensive, worldwide database, or enter any place you like such as lakes, dirt strips, or heliports.

PEOPLE
Track every person involved with your logbook, from crew to students, and passengers to examiners.

CERTIFICATES
Tracks certificates – e.g. Instrument, Commercial, Medical, Type rating etc.
Easily customize the LogTen Pro Toolbar

You can also easily customize the LogTen Pro toolbar, adding, removing or changing the order of the different items to your preference.

To get started, select “Customize Toolbar...” from the View menu.

Rearrange
To change the order of items on the toolbar simply drag and drop them into your preferred order.

Remove
To remove an item simply click on the item, hold and drag it off the toolbar area.

Add
To add an item, choose it and drag it into your preferred position on the toolbar.

You can also customize your toolbar by adding fixed and flexible spaces as well as separators.

Chapter 2  Features at a glance
Save Time

At the bottom of the Flight view screen you will find a great time saving device to simplify data entry.

**NEXT LEG**
Auto-enters relevant data from last leg to the next leg, transferring “to” airport to “from” airport.

**RETURN TRIP**
Auto-enters relevant data reversing “to” and “from” airports.

**DUPLICATE**
Flying the same route often? Highlight the relevant flights (you can highlight more than one if there are a number of legs) and click the “Duplicate” button.
New in LogTen Pro for Mac 5.5

Our latest update includes new features and enhancements that make logging time even easier for pilots whether they’re in the air or on the ground. This update will be especially useful to commercial and business pilots and includes:

SYNC WITH THE ALL NEW LOGTEN PRO FOR IPHONE AND IPAD
LogTen Pro 5.5 adds support for a new sync system that lets you manage all your devices from the Mac, and sync with the powerful new LogTen Pro apps for iPhone and iPad.

TRIPS
LogTen Pro Mac’s new Trips tool which gives Airline and Business pilots the flexibility and control they were looking for to keep track of their time and pay whether in the air or on the ground. Pilots can now assign multiple flights to a single ‘Trip’, they can input a per diem rate for flights as well as all other types of duty including Airport reserve, Business, Commute, Deadhead, Home reserve, Reposition, etc., and they can also easily keep track of any expenses incurred on the trip.
MORE AIRLINES
Over 50 more airlines have been added to the popular “schedule importer” function which enables pilots to import their flight schedules directly into LogTen Pro, saving a huge amount of data entry time. This includes AIMS and iCal schedules and doubles the number of airlines supported by the functionality to over 100 worldwide. For a full list of supported airlines [click here](#).

MY.LOGTEN.COM
Pilots can now share their logbooks online by publishing them direct from LogTen Pro Mac to Coradine’s online logbook sharing site at www.my.logten.com.

FASTER MORE EFFICIENT DATA ENTRY
And we’ve also enhanced the Auto-enter and ‘picker’ features to make entering data even faster.
Customizing or changing LTP configuration

If your status changes or you wish to customize the configuration of LogTen Pro specific to your situation, you can do this in the ‘Configure LogTen Pro’ window.

Changing base configuration for new status

Once in the Configure LogTen Pro window, you can easily change your base configuration with the “Base Configuration” drop down menu, simply click on your new status in the menu and your configuration will change automatically throughout LogTen Pro.
Customizing your LogTen configuration

The Configure LogTen Pro window also allows you to easily bypass the base configurations and completely customize your columns for all aspects of your flying.

Simply select a tab, then adjust titles, setup custom fields! Use the checkboxes to pick which fields should be displayed as a column in the table. Remember you can always access any field in the Flight Detail view even if you have selected not to have a column for it.

Tip: Changing the title of a field does not change its function. So if you change the Title of “Dual Received” to “Pilot in Command” all your “Pilot in Command” time will appear in the Dual column on reports. Reports reference specific fields no matter what their title and cannot dynamically guess what you meant by looking at your title.
Customizing your LogTen Pro preferences

You can easily change your LTP preferences depending on what type of flying you do or your personal preference regarding time/font size format.
Customizing your LogTen preferences - General

1. Choose your flight time format preference.
2. Choose preferred place identifier and preference regarding auto fill of place data.
3. Choose how you like to see and reference individual aircraft. Primary id is generally the aircraft registration number (e.g. N123AB), and many people use the secondary id for airline tail number (e.g. 123).
4. You can select whether you want to see people by their name or employee ID.
5. Choose between decimal or degrees and minutes formats for latitude and longitude.
6. Select the font size that is comfortable for you.
1. LogTen Pro is configured to automatically check for updates. You can bypass this feature by unchecking the ‘Automatically check for updates (not recommended)’

2. You can also manually check for updates by clicking on the “Check Now” button

3. Automatically download updates in the background if you prefer not to read the release notes and just get the latest whenever it’s available
Customizing your LogTen preferences - Registration

When you purchase a license, enter your email and license key to fully activate LogTen Pro.

If you owned a previous version of LogTen Pro for Mac and purchased an upgrade license, enter the new license first, then fields will slide down to allow you to enter the old license if needed.
Customizing your LogTen preferences - Advanced

In the Advanced screen of Preferences you can set the number of years of flight data to display, choose to see months, and choose to have all dates and times in Zulu (UTC).

LogTen Pro also enables you to track all times in station local (the timezone of the place(s) where the flight took place), or if you have a need to track ALL times in a single timezone like Southwest Airlines does, you can select a specific timezone from the list.

Flights view showing Advanced preferences of 4 calendar years with months displayed.
Customizing your flight table view

Moving columns

To re-arrange columns in any table in LogTen simply click and hold on the header (where the title is) and drag it to the position you would like.

By arranging your columns in the same order as a paper logbook or your airlines roster it makes data entry a snap.

Sorting

You control sorting by clicking once on a column heading. Click on “Date“ and your flights will be sorted by date (the default). A small triangle appears in the column heading indicating the sort direction. Point up, or smallest to largest, means the data is sorted ascending, so for a date this would mean the oldest first. Click the column again, and the sort order reverses.

It’s important to note that the way new flights are added is affected by sort order. If your data is sorted ascending (smallest to largest) then new flights will be added below the current selection (if there’s no selection they’re added at the end). If your data is sorted descending, (for dates this would be newest at the top) then new flights are added above the current selection. This applies to Next Leg, Duplicate, and Return Trip as well.

Resizing

In a similar fashion to re-arranging, columns can be resized as well. Place your cursor over the dividing line in between columns in the header of the table and you will see it change from the standard arrow to a vertical line with a small arrow pointing in either direction. Now click and drag to make the column larger or smaller.
Saving your logbook

We recommend you save your logbook immediately prior to entering flight information, this way, LogTen will autosave data continually as you input it.

Name the file and click “Save”.

Please note that LogTen Pro will autosave your data to ensure you don’t lose any data inadvertently.
Importing flight data

The LogTen Pro import sheet will open, displaying a table. On the right you’ll most likely see a list of repeating “Do Not Import” items, and on the left the column headings from your data.

To import your data you go down the list, and for each item click the “Do Not Import” (they’re menus) and select the appropriate item. E.g. if the first item in your data is “Date”, then you would select “Flight -> Date” from the menu next to the cell where “Date” appears in your data.

You can use the left and right arrow at the bottom to page through your data to verify it’s going to the right place.

Make sure you map the aircraft type

It is important that the aircraft type (usually a concatenation of make and model such as B752 for the Boeing 757-200 or C172 for the Cessna 172) be mapped correctly, as LogTen Pro wants to have only a single entry for each aircraft type and it then links every aircraft of that type to the same aircraft type entry. This is a huge time saver and enables many features down the road. We recommend you read Chapter 9 on “Managing Aircraft” before proceeding.
Adding a new flight

When you are ready to start entering new flight data, you can either use the “Quick Entry” tab in the flight details screen or simply click on the “New Flight” Icon and tab through the flight table filling in the columns with appropriate details.

**Entering flights directly in the table**

Click the “New Flight” icon and a new, empty row will appear, with focus in the date field in the table view.

*Tip: Use Command-N to quickly make a new flight, and use the up and down arrow keys to add or subtract a day from the date!*

Tap the ‘tab’ key to easily move through the remaining columns filling in flight details as you go.

You can also delete flights at the touch of a button, either by clicking on the red Delete button at the bottom, or by using the ‘delete’ key on the keyboard.
**Entering data in the Flight Details view**

The flight details screen can be accessed through the “View” menu:

Choose View -> Show Flight Details...

*OR*

Use the Toggle button at the bottom right of the screen.

Flight details screen appears below the flights table with “Quick Entry” tab open

Click the “New Flight” icon and the “Quick Entry” screen clears with today’s date auto-filled. Simply Tab through filling in the new flight details.
The tabs in the Flight Details screen enable you to quickly enter all the information you need to keep track of your flying no matter what your configuration. Here you can always access every field, even if you have chosen not to show the column in the table view.

**QUICK ENTRY**
This tab takes the most common fields based on the configuration you’ve chosen, and puts them in one place to facilitate efficient data entry.

**FLIGHT**
General flight info such as out and in times, aircraft, and departure and arrival points.

**LANDINGS**
Log every type of landing you can imagine from water landings to carrier arrests, and if that’s not enough you can of course create your own!

**OPERATIONS**
Log instrument approaches, holds; glider operations, or create your own to track any integer value you need.

**TIME**
Log over 32 different types of time, and that’s not including times by type such as Multi-Engine Land or Jet which are tracked automatically!

**DUTIES**
Track your duty time, pay, earnings as well as capacity on the flight. Use the custom checkboxes to easily track things like deadhead flights.

*Tip: Using Smart Groups you can easily filter flights to only show flights that were NOT deadheads, or based on any other property.*

**PEOPLE**
Here you can quickly log the Pilot In Command and Second in Command and easily swap them back and forth, as well as add any number of crew and passengers!

**NOTES**
Everything from remarks and weather, to related certificates and your own custom notes.

**JOURNAL**
It’s your career or your passion, write as much as you like and add a photo so you can remember every adventure or crazy crew member!
Track your time ... in the air ... and on the ground

Now you can track trips independently of flights, enabling you to track all your time and expenses (not just flying time) for the trip as well as group legs together for better organization and easier viewing.

Here’s an example of how the new Trips tool works:

**STEP 1:** Click on “Trips” on the LogTen Pro navigation bar, this is what you’ll see:
STEP 2: Click the “+” button at the bottom left of the screen to add a new Trip

STEP 3: You can then either tab through the table itself and enter the details of the trip OR enter details in the “Overview” section lower left of the screen.

Note that you can choose from a number of different “Types” of time, including Airport Reserve, Business, Commute, Deadhead, Flight Duty, Home Reserve, Non-flying, Personal, Reposition Air or Reposition Ground.

Tip: You can also enter any text you like in here for the trip type, you’re not limited to the choices in the menu.

STEP 4: Enter the Start and End times for the trip. For this example we’re going to use Flight Duty time from 06/10/08 at 5:00 AM through to 07/10/08 at 5:00 AM. The flights included in this time-span will automatically appear in the Flight area at the lower right of the screen.

Tip: The time format is based on your system settings! To change date format or switch between 12h and 24h formats open System Preferences, then choose Language & Text -> Formats. (Note, on versions of Mac OS X prior to 10.6 it’s called “International”).

STEP 5: If you track earnings based on an hourly rate, you can enter this rate in the Overview section and LogTen Pro automatically calculates your earnings.

STEP 6: You can also track expenses for your trip, whatever the expense, you have total control and flexibility with LogTen Pro Mac. Add or remove expenses simply by clicking the “+” or “-” sign at the bottom left of the Expenses tab.
If you need more guidance with the Trips tool, please don’t hesitate to contact us!
Creating stunning reports and logbooks

LogTen Pro comes with over 30 built-in high quality reports including the ability to print incredible logbooks that look just like the official formats for the USA, European Union, Canada, Switzerland, Australia, China, Argentina, South Africa and New Zealand, just to name a few.

Can’t find what you’re looking for? Using the WebKit engine that drives Safari, LogTen Pro allows you to create your own.

For this example we chose “ASA Pilot Master Log Full Remarks 26”.

The menu at the bottom of the screen is set to “All Data”. You can click here to choose how much data to include on your report. If you choose “Custom Date Range” on the drop down, you can specify specific start and end dates.
Saving and sharing your report

After clicking “Generate Report” the screen below will open up and give you the options to:

• “Share via LogTen.com...” – which will post your logbook on the LogTen.com site and send a link via email to the person you designate (shown on the next page)

• “Save As...” – which will save your report as an .it’s raw source, such as html, text, ICS (calendar), or KML (Google Earth).

• “Print” – which will print your logbook, providing your printer is connected and switched “on” :-). Important: This is also how you generate a PDF!

NOTE: The content is intentionally shifted to allow for binding when printed, it’s not off center by accident!
Sharing your report continued

With LogTen Pro 5.5 you can share your report with others via our LogTen.com site. Here’s how it works:

![Image of Pilot Logbook]

Click on the “Share via LogTen.com...” button and a pop-up appears asking “Where should we send it?”. Type in the recipients email address and a link will be sent immediately.
Here's what the email looks like:

Hello,

A logbook report has been generated and uploaded from LogTen Pro for you to view.

**View the report:**
The report will be available here for one week.

**Delete the report:**
If you would like to remove it before it expires, [click here](#).

Best regards,
The LogTen Pro Team

[my LogTen.com](http://www.mylogten.com) is a service provided by Coradine. [Learn more](http://www.coradine.com).
Creating a custom report

LogTen Pro gives you extreme flexibility in the types of pilot logbook reports you generate. Using the power of HTML, CSS, JavaScript, and virtually any other technology you can use in a web page you can create pretty much anything you can imagine. This article will walk you through creating your first template, and give you the tools you need to start creating whatever you need. Whether you want to add charts, and graphs, or need to track a specific type of flight time on your report, it’s all possible with LogTen Pro.

Getting Started

Report templates in LogTen Pro live in a special folder in your “home” folder, located at ~/Library/Application Support/LogTen Pro/, here you will find two important folders, “Sample Report Templates” and “My Report Templates”.

LogTen Pro will look for your template in the “My Report Templates” folder, so the easiest way to start a new template is to copy one from the “Sample Report Templates” folder into the “My Report Templates” folder.

Style

For each report template there is Cascading Style Sheet (CSS) file called “style.css”. In this file you specify the report type, name, description, author, version, number of rows per page, etc. AND here is where you define all the styles that apply to the report. This means you can affect numerous things, including colors, column widths, fonts, sizes, etc.

Going into the details of working with CSS, it’s rules, formats, and capabilities is beyond the scope of this document, however there are numerous references online, that should help you if you are unfamiliar with it. Many things should be fairly obvious simply by browsing the style.css file.
The Report Components

The various report styles, such as one page, two page, totals, have slightly different sets of HTML files, however they are very similar. Primarily they will consist of:

- **Document Header and Footer**
  These will occur only once for the whole report, the header at the beginning, and the footer at the end.

- **Page Header and Footer**
  These will occur once for each page of the report, the header at the beginning, and the footer at the end.

- **Page Row**
  These will occur for every row of the report.

Keys and telling LTP where to insert data

Within each of the files are keys for LogTen Pro where data is to be inserted. Each marker looks like `<?ltp keypath=xxx; ?>` and has a key ("flight_totalTime" for example) that LTP uses to replace with data from the current flight as it builds the report, for example every time LTP comes across this:

```html
<?ltp keypath=flight_totalTime; ?>
```

it will replace it with the total time for the current flight it's inserting.

_Tip: a complete list of report keys is available in the Help->Display Available Report Keys menu in LogTen Pro_

In addition to the key itself, there are a few other optional additions:

```html
dateFormat="MM/dd/yyyy";
```

For any items that are a time or a date, you can customize the format. For a complete list of available formats, go here: [http://unicode.org/reports/tr35/tr35-6.html#Date_Format_Patterns](http://unicode.org/reports/tr35/tr35-6.html#Date_Format_Patterns).

```html
predicate="flight_totalTime > 0";
```

This is a logical statement that will only replace the main keypath with a value if the predicate returns true, for example:

```html
<?ltp keypath=flight_totalTime; predicate="flight_PIC > 0"; ?>
```

will show the total time for a given flight, but only if there is PIC time on the flight as well.
@sum.

This is used in front of a keypath to indicate that you want the sum of the key rather than the value from an individual flight.

```xml
<?ltp keypath=@sum.flight_totalTime ?>
```

will give you a sum of total time for all flights that took place before the current location in the report.

```xml
scope="forward";
```

This is an optional addition when you are working with a key that has an @sum in it, "page" will give you the total for the current page, "forward" will give you a balance forward total or a carry forward total, depending on if it’s at the top or the bottom of the report page.

**It’s easy!**

With only a rudimentary knowledge of HTML and CSS you can create powerful custom reports. Browse the other help articles in our knowledge base at help.coradine.com for detailed instructions on accomplishing specific tasks.
Managing your aircraft

In LogTen Pro, you can manage a list of aircraft types to help reduce data entry, since most pilots will fly multiple individual aircraft of the same type. LogTen Pro’s default aircraft type designators follows the FAA’s classifications.

Click the “+” button to create a New Type.

Now if I fly a fleet of 757’s, in the Aircraft tab I just enter the Aircraft ID, and select the type, and I don’t have to specify that it’s a Multi-Engine Jet Airplane for every Aircraft I enter. For each individual aircraft, I can then track things that are unique about that particular aircraft such as avionics configurations.
Options galore!

With LogTen you can also manage your aircraft by aircraft ID. This enables you to keep track of not only Aircraft ID and that particular aircraft’s features, but you can also keep track of Owner/Operator details as well as keep track of maintenance and inspection activities. You can even keep a photo of each aircraft you fly!

Click the “+” button to create a Aircraft.

Checking the “Favorite” box means the chosen aircraft will be listed in blue bold type on the Mac. And when syncing to a mobile device, the Favourite will be listed first for easy, quick selection.

Checking the “Default” box means the chosen aircraft will be autofilled when you add a new flight.
Managing Places in LogTen Pro

In LogTen Pro 5 you can manage a database of places. When you enter a From or To value for a flight it looks for a match in the internal database of over 28,000 places worldwide and if it finds a match, will automatically create a new entry in your “Places” list. If the field is STILL not found it will simply create a new empty entry in your Places tab and set its’ identifier to whatever you entered for the flight in the "From" or "To" field in the Flights view. This allows you to track any place you fly whether it’s KJFK, a nav aid, or your grandmothers back yard.

Click the “+” button to create a New Place.

More than meets the eye

The "From" and "To" fields are much more than just a few characters, it’s a link to a specific place that allows LogTen Pro to do things like calculate the distance of your flights, instantly change how your "From" and "To" fields are displayed (in the Preferences you can select from Identifier, ICAO, IATA, or Name) as well as a reverse relationship to every flight that uses it so that you can look at a particular place and instantly see how many arriving and departing flights you have.
From and To places should always be a single identifier. Route information should be entered in the "Route" field.

VERY IMPORTANT NOTE REGARDING ROUTE:
Route is used for calculation of distances, and is normally expressed in terms of airports, not navigational aids such as VORs and GPS waypoints. If you want to use waypoints you will need to pre-enter them along with latitude and longitude in the Places tab. We are working to add a waypoint database in the future.

Many pilots like to record a days flying as a single entry, and it is not uncommon to see a sequence of sectors in the "From" or "To" field. For example on a flight from Denver International Airport to Seattle's SeaTac Airport via Los Angeles International and Phoenix Sky Harbour you might see something like this in the "From" field: KDEN-KPHX-KLAX and then KSEA in the "To" field. As you may have already guessed from the first paragraph, this will result in a new airport being created in your list with the ICAO ID of "KDEN-KPHX-KLAX": not good. So the next time you go to enter a flight to KPHX, you'll get "KDEN-KPHX-KLAX" auto entered because it found a match!

So the way it was designed, you would enter the starting point, and the end point, and then enter route information in the route field. Note that at any time you can choose "Get Place Data" under the Manage menu to fill in missing data from the internal database where available. This means if you've got an airport with just an ID, such as KDEN, running this command will look up KDEN in the internal database and fill in the IATA, the Name, Lat, Lon, City, State, Country etc if the information is available.

Places "Notes"

CONUS and OCONUS fields are useful for tax purposes in the US, but can be customized as desired.
Places “Trips”

All trips relating to the chosen “Place” will be displayed when you choose the “Trips” tab at the bottom right.

Places “Flights”

All flights relating to the chosen “Place” will be displayed when you choose the “Flights” tab here.
Places “Expenses”

All expenses relating to the chosen “Place” will be displayed when you choose the “Expenses” tab here. You and add and remove expenses incurred at this location.
From crew to passengers, owners to operators

View and edit the information about the people you fly with. Click on a name to see all the flights they are on and what role they had, add a picture or edit contact details.

Click the “+” button to input a new person.

Checking the “Favorite” box means the chosen person will be listed in blue bold type. And when syncing to a mobile device, the Favorite will be listed first for easy, quick selection.

All flights with the chosen person will be displayed when you choose the “Flights” at the lower rate, and you can also select the certificates tab to see all certificates you have issued to this person, very useful for instructors!
Certificates

LogTen makes it easy stay current

Keep track of your Pilot Certificates, Medical, BFRs and Endorsements, by type and expiration. You can even attach pictures (e.g., a scanned copy of the original) to each one for your reference. If you are a Flight Instructor, you can also keep track of each endorsement you give to your students, and the applicable expiration date of those endorsements.

NOTE:
Another great feature is that your next expiring certificate will be automatically displayed in the flights view when you open LogTen Pro!
Smart Groups

Harnessing the power of Smart Groups

Smart Groups is one of the most powerful features of LogTen Pro. Smart Groups lets you quickly view your totals based on any attribute of your flight. So you can easily and quickly see totals in the left hand ‘groups’ column of the LogTen Pro “Flights” View.

When you launch LogTen Pro 5 for the first time, you start off with a few standard smart groups including Currency information for Day/Night and Instrument time. As well as duty limits including 12 months and 28 days.

LOGBOOK
These Smart Groups are standard and will display total time for the period.

CURRENCY
Displays the number of days remaining until you’re no longer current. You can configure by double-clicking, or create your own. You can also specify when they change color to warn you when you’re getting close!

LIMITS
By default these display hours remaining until you hit your limit. You can double click to change them, or create your own!

SMART GROUPS
Build your own customer groups to quickly track totals like Tailwheel, Multi-engine, Jet, or flights with a particular student. You can filter on anything, so the sky’s the limit!
What you can do

These standard Smart Groups are the tip of the iceberg! Dig a little deeper and you will find an incredibly flexible and versatile tool which enables you to:

• Track totals for ANY criteria you choose, and you can customize criteria specific to your situation … want to see flights logged with night time greater than 2 hrs in a B757? No problem.

• Look forward and back in time – so you can make a “30 in 7” duty limit that looks back 6 days and forward 24 hours for example

• Set maximums for currency groups, enabling you to handle currencies that require a certain amount of one thing but no more then X of another. E.g. 3 hours total instrument, but no more than 1 hour simulated.

• Choose from several options for what data to display next to the group, instead of just Total Time you can choose from PIC Time, Landings, or a count of matching flights

Creating a Smart Group - Step 1

Click the “+” button at the bottom left of the main screen and choose “New Smart Group”. Alternatively click “File” -> “New Smart Group”.

Chapter 2 Features at a glance
Creating a Smart Group - Step 2

Name your smart group. For this example, we're going to sort for Noah based on Aircraft type (C172) and time logged as PIC. So we'll name the group “Noah PIC in C172”.

![Smart Group Configuration Window]

- **Dynamic Date Range**: Flight in the last: [ ] Months, And flight in the next: [ ] Hours
- **Match**: All of the following criteria.
- **Display Options**:
  - Show results as: Total Time
  - Result color thresholds: 0, 14, 60, All
Creating a Smart Group - Step 3

Set the date range. You can look back as well as forward to keep an eye not only on where you’ve been but make sure you’re not hitting limits anytime in the near future. For this example, we’re going to look at PIC time logged in C172 for the last 12 months.
Creating a Smart Group - Step 4

Choose your criteria. Please play around with this, you’ll see that with the ability to customize criteria, you can pretty much sort based on anything your heart desires. For this example, we choose “Aircraft Type”, “Type” and “is” C172 … then we hit the “+” button to add a second set of criteria.
Creating a Smart Group - Step 5

We set a second criteria for “Crew”, “PIC”, “Begins with”, noah (the search is not case sensitive, so it will match Noah, or noah or NOAH.)
Creating a Smart Group - Step 6

If you wish, you can manually key-in color thresholds to let you know when we're getting close to your specified limit or goal.

Click OK and voila, your new smart group is tracking your totals.

P.S. If you want help setting up a more complicated Smart Group or further guidance, please don't hesitate to contact our support team!
LogTenPro for iPhone, iPod Touch or iPad

1. Make sure that your device and Mac are connected to the same wireless network (see note about wireless networks below).

2. Open LogTenPro on both the device and Mac.

3. In the "Flights" tab on the Mac, select the name of your device under "Devices".

4. Click "Pair", and type in the 4 number code that appears on your phone (Pairing with a device only needs to be set up once :-)

5. Click “Sync Now”.

NOTE: If you do not see your phone, option-click or right-click on DEVICES and select Refresh.
LogTen Mobile 2.4.x

To sync your LogTen Mobile data on your iPhone or iPod Touch with your data on your Mac in LogTen Pro you generally just need to select the Sync tab in LogTen Mobile and tap the "Sync Now" button.

If you are experiencing any trouble, please try the following steps:

1. Make sure your Mac and iPhone are on the same local network (see note about wireless networks below).
2. If your phone is connected using USB cable, disconnect your iPhone from the Mac. Syncing is over WiFi and some users have reported trouble when the device is connected to iTunes.
3. Quit LogTen Pro, and LogTen Mobile. If you are using iOS 4, make sure the app is fully quit and not in background state.
4. Open LogTen Pro on the Mac making sure to have the Flights tab open. Then launch LogTen Mobile on your device.
5. On your iPhone, select the Sync tab and select your active logbook from the list. This filename should end in a .logten. If the iPhone can’t find your file, you may need to set it using the "Settings" button in the upper left corner of the Sync screen.
6. Tap the "Sync Now" button.

General Tips for all Mobile Device Applications

Syncing should complete within a matter of seconds, if it goes longer then 3 or 4 minutes it’s almost certainly not going to complete. (NOTE: If you have a lot of images, then it could take longer.)

FIREWALL

If the sync starts but then seems to run forever, it's most likely being blocked by some sort of security like a firewall or third party app such as Net Barrier, or even some hotel networks. Go into the Security pane of System Preferences and click the "Firewall" tab and ensure that it is set to "Allow all incoming connections" or that you have added LogTen Pro to the allowed list.

HOW TO CREATE A COMPUTER-TO-COMPUTER NETWORK

Also, if you’re trying to sync on a hotel or airport wireless network it’s possible they are blocking the ports that LogTen needs to sync. If this is the case, you can create a private network between your Mac and iPhone and see if this resolves the issue. To do this choose "Create Network" from the Airport menu on your Mac (located in the menubar at the top right of your screen near the clock), then
connect your iPhone to this network and try the sync again. To be on the safe side, it’s best to quit both LogTen Pro Mac and iPhone before switching to your new network, then launch them again to ensure they’re communicating on this new network.

If you continue to have any difficulty send us an email and we’ll be happy to assist you right away!
My License Won’t Activate

If you’re having trouble activating LogTen Pro, it’s almost certainly due to one of two reasons:

**The Owner and Activation code do not match**

Make sure you copy and paste BOTH the owner (email) and activation code from your original receipt email. If you’re using an upgrade license enter the new upgrade license first, you will then be prompted for your qualifying older license.

**The license you are using does not match the version of LogTen Pro you’re trying to activate**

You can verify the version of LogTen Pro you have by selecting “About LogTen Pro” from the “LogTen Pro” menu. Version 3 licenses start with “LTP3”, version 4 licenses start with “LTP4” and likewise, all licenses for version 5 begin with “LTP5”.

**Why isn’t my report showing any times?**

If you’re using a report that breaks time down by aircraft type, such as the Canadian, South African, Australian, and others, you need to be sure your Aircraft Types in LogTen Pro are complete.

Because LogTen Pro tracks your time by type automatically, you have to be sure that each Aircraft Type (click Manage, then go to the Types tab) has valid Engine Type, Category, and Class information. If this is missing LogTen Pro doesn’t know if the flight was Single-Engine or Multi-Engine and so can’t fill in the data on the report!

**Where can I get a professional binder and paper?**

Looking for the “Special logbook paper” mentioned in the reports in LogTen Pro? Look no further! While LogTen Pro’s logbook reports can be printed on standard paper, they are designed to be printed on these pre-drilled papers and placed in these high quality leather logbook binders! You can order [here](#).
Can I use a person's ID rather than their name?

There's a preference (choose “Preferences” from the LogTen Pro menu) that allows you to specify whether you prefer to display people using their name or their ID. This is just like the way you can set a preferred display type for Aircraft and Airports. You can always enter a person using either one! So when you want to enter someone, in the name field, simply type their name OR their ID and it will give you a list of matching people to select from.

Also note the new handy button to swap the PIC and SIC. This is especially useful if you often fly with the same person but switch rolls. You can set defaults so you're always added as the PIC or SIC, then just use the button to switch as needed.

How do I see my time for MEL, EFIS, High Performance, Tailwheel, etc?

Through the power of Smart Groups LogTen Pro lets you quickly view your totals based on any attribute of your flight. LogTen Pro saves you time by reducing the amount of data you have to enter. Rather than typing the same value over and over to fill in the amount of hours you have by having a column for MEL, another for EFIS, another for Turbine, etc. You simply enter the total time, and things like PIC/P1 and tell LogTen Pro which aircraft the flight was in.

Now if you want to know your Tailwheel time you simply create a new Smart Group by clicking the “+” button at the bottom of the groups list, and set it up like this:

Now you can always see your total “Tailwheel” time next to the group, and when you select it it will show only flights that match, and ALL your totals at the bottom of the table will be “Tailwheel” totals so you can see at a glance how many Tailwheel landings you have, how many hours PIC, etc.

You can use Smart Groups to “filter” your time just about any way you can imagine!

What aircraft type designators does LogTen Pro use?

Is it “DHC8″, “DHC8-200″ or “DH8B”? If you've been trying to guess what type designator to use to get LogTen Pro to automatically fill in your Aircraft Type data, guess no longer! LogTen Pro uses a standard data set published by the FAA which can be found [here](#).
This document should be a big help if you’re having trouble getting LogTen Pro to recognize your aircraft types, most likely they ARE in the database, but the FAA may use a different designation.

Tracking multiple approaches

If you have a need to track more than one approach type on a given flight, there’s actually more than one way to do this in LogTen Pro, depending on the level of detail you’d like to record.

You can either use the approach type to enter as much text as you like, so for example you might enter VOR 2; ILS 1; NDB 2. This gets the job done, and may be the simplest approach, however it does not allow you to keep running totals of the various types of approaches you’ve done.

If you want more accuracy, such as the ability to track the exact number for each different type of approach and see running totals for them, then we recommend customizing some of the custom operations fields.

If you click the “Configure” button in the toolbar and then go to the “Operations” tab, you’ll find that there are ten custom fields that you can change to whatever you like. So you could make separate fields for ILS, NDB, VOR, all the types you want to track, then for each flight simply enter the number in each box!

Saving time: Aircraft Type vs. Ident

Many paper logbooks have you enter the “Type” first, however in LogTen Pro it’s much better to enter the Aircraft ID first because in LogTen Pro an aircraft can be linked to one and only one Aircraft Type, whereas an Aircraft Type can have many different individual aircraft.

By entering the Aircraft ID first you’re much more efficient because there’s no need to enter the type, whereas if you enter the type first then you still have to enter the id… So ultimately the point is, I highly recommend you arrange your columns so that the Aircraft ID comes BEFORE the Aircraft Type and you always enter the Aircraft ID first.

When do Smart Groups totals update?

Wondering why the totals displayed next to your Smart Groups don’t update instantly?

Basically a smart group can have criteria for any attribute of a flight, and so ANY change to a flight could effect ANY group. This would mean that in order to keep them up-to-date in real time every group would have to be re-calculated every
time you changed ANY value on ANY flight. It takes an average of 200 milliseconds per group. By default there’s 56 groups, that means you’d be looking at an 11 second pause every time you changed a value and tabbed to a new field.

Group totals are all updated every time you open the logbook so your currency numbers will be up to date.

How do I enter a balance forward?

If you have time from existing logbooks that you’d like to enter as a starting point in LogTen Pro rather than manually entering all that existing flight time, it’s quite simple.

ENTER A FLIGHT WITH TOTALS FOR EACH AIRCRAFT TYPE
To enter past totals just create one or more flights and enter the total times you’d like to use as starting points, you can set the date to whatever you like (probably the date of the last flight included in the total would make sense). You can decide how much detail you want, e.g. you simply enter one flight and set the appropriate totals (1139 PIC, 874 Night, etc.) or you could add a separate flight for each aircraft type to be more precise.

A NOTE ABOUT TIMES LIKE JET, AND MULTI-ENGINE LAND…
Because LogTen Pro automatically tracks time by type, such as Multi-Engine, Jet, etc, if you want these totals to be correct it’s important to specify the correct type for your balance forward entries. Because we’re just concerned with Engine Type, Category and Class you can simply create some generic types that cover all Jet, Multi-Engine Land, Airplane…

IF YOU USE REPORTS THAT DISPLAY EACH TYPE OF TIME AS DAY AND NIGHT…
If you plan to use reports that break time down into day and night, such as the Canadian or South African reports, then when you enter a balance forward you should make a separate entry for each type of time. E.g. one for your PIC/P1 totals (including night), one for SIC/P2, one for Dual, etc. Otherwise the reports will see PIC, SIC, Dual and Night all on the same flight and it will be unable to calculate the day/night totals correctly.

Tracking certificates: When is my medical due?

How to Easily Track the Days Remaining Until Your Next Medical:

1. Open the Resource Manager
2. Select your record in the AddressBook tab (add a new one for yourself if you haven’t yet)
3. Tick the “This is Me” checkbox
4. Select the “Certificates” tab of the Resource Manager (at the top)
5. If you’ve already added your medical select it, if not create a new medical certificate and enter the particulars.

**The key is that you select yourself as the pilot.**

In the LogTen Pro AddressBook, similar to Apple’s AddressBook, your personal information is simply another entry. So make sure you add yourself.

Now equally important is the fact that the only way LogTen Pro knows which record is yours is if you tick the “This is Me” box. Now when you endorse certificates, or set yourself as the pilot you’ll see them in your record in the AddressBook, and more importantly in this case the status display both in the main window and in the Resource Manager will now be able to display the days remaining until your certificate expires.
If in doubt, repair!

New to LogTen Pro 5 is the “Repair” function – if you experience strange behavior, try repairing the logbook until you get a "No Repairs Needed" dialog.

Still having trouble? Get help:

Go to www.help.coradine.com to work with LTP community in the public discussions, or start a private discussion with the Support Staff directly!